
ZX Spectrum Game Maker
Summary: Herramienta para crear juegos para ZX Spectrum de manera visual.
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Introducción
Herramienta para crear juegos para ZX Spectrum de manera visual usando Tiled  y el editor de
imágenes que prefieras.

Recomendamos usar ZX Paintbrush , pero puedes usar el editor que quieras siempre y cuando
las imágenes cumplan las restricciones del ZX Spectrum (color, tamaño)

Fase Beta IMPORTANTE

ZX Spectrum Game Maker se encuentra todavía en una fase beta con funcionalidades pendientes
y a falta de un testeo intensivo. No se recomienda para un uso ya final, si bien tiene un estado muy
avanzado en muchas de sus posibilidades, hay que ser consciente que no está en estado de
lanzamiento.

Documentación en vídeo
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IMPORTANTE: Los vídeos son una buena guía para entender como funciona el motor, pero como
el mismo está en costante desarrollo hay cosas que pueden haber cambiado, por lo que para tener
una documentación más exacta es mejor consultar esta que estás leyendo.

Curso por módulos en el canal de Juanje Juega :

1. Instalación e Imágenes 

2. Diseñando el juego 1/2 

3. Diseñando el juego 2/2 

4. FX y Música 

Podéis ver una presentación WIP en el siguiente vídeo:

Video en Arnau Jess 

Tech
ZX Game Maker usa Boriel’s ZX Basic , GuSprites sprites library  y python para scripting

Telegram
Si tienes dudas y quieres participar con otros desarrolladores que están usando el ZX Game Maker,
podéis acceder al siguiente canal de Telegram:

Grupo de Telegram: https://t.me/zx_spectrum_game_maker 
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Y a todo el grupo de ZX Basic de Boriel de Telegram
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Instalación. ZX Paintbrush
Summary: Necesitas un editor de imágenes para diseñar algunas pantallas de tu juego
como la pantalla inicial, carga, principal... Y el conjunto de tiles (los cuadraditos que sirven
para diseñar las pantallas) y sprites (Personaje principal, enemigos...).
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Instalación

¿Porque el ZX Paintbrush?

Instalación
Necesitas un editor de imágenes para diseñar algunas pantallas de tu juego como la pantalla inicial,
carga, principal… Y el conjunto de tiles (los cuadraditos que sirven para diseñar las pantallas) y
sprites (Personaje principal, enemigos…).

Cada una de las imágenes del engine tiene su fichero .zxp (loading.zxp, title.zxp, hud.zxp,
ending.zxp) para que lo edites desde ZX Paintbrush cuando tengas que generar el juego.

ZX PAINTBRUSH 

Si eres usuario de linux o mac lo podrás ejecutar perfectamente con wine.

¿Porque el ZX Paintbrush?
Inicialmente el motor trabajaba con png, pero las imágenes para zx paintbrush tiene más datos de
los que un png puede guardar:

De los dos colores de un caracter cual es el “paper” o el “ink”

Brillo del caracter activado o desactivado

Flash del caracter activado o desactivado

Podriamos haber seleccionado otro programa que tambien maneje estos datos, pero por secillez de
uso, funcionalidades y facilidad de manejo de ficheros del proyecto hemos elegido el ZX Paintbrush
de Claus Jahn
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Instalación. Tiled.
Summary: Este Game Maker usa Tiled para diseñar el mapa de tu juego y posicionar
todos los elementos en el mismo.

Este Game Maker usa Tiled para diseñar el mapa de tu juego y posicionar todos los elementos en
el mismo.

Además desde el mismo programa podrás configurar opciones generales de tu juego.

DOWNLOAD TILED 
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Instalación. Docker
Summary: Herramienta para que el ZX Game Maker funcione en todos los Sistemas
Operativos (Windows, Mac OS y Linux)

Para que este game maker funcione correctamente en todos los sistemas operativos, lo hemos
“empaquetado” usando la tecnología docker, de manera que simplemente instalando esta
tecnología en tu ordenador, deberías poder generar tu juego.

DOCKER 
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Instalación. Tu Proyecto.
Una vez instaladas las herramientas ya solo tienes que descargarte el “skeleton” de tu
juego/proyecto, que es como una plantilla con un juego muy sencillo para que ya tengas todo
preconfigurado, y que puedes cambiarlo para hacer tu juego.

Al descargar el skeleton/proyecto, descomprimirlo y cambiar el nombre de la carpeta por el nombre
de tu juego no uses espacios ni acentos, diéresis… para este. Por ejemplo podéis usar guiones
medios y nombrar a la carpeta como mi-juego-super-molon.

DESCARGAR EL SKELETON DEL PROYECTO 

Todo lo que influye a la hora de generar tu juego se encuentra en la carpeta assets, con lo que os
recomiendo que vayáis haciendo copia de esa carpeta por el método que prefiáis (Copia manual,
control de versiones…).

La manera de trabajar es simplemente modificar los elementos dentro de la carpeta assets,
maps.tmx, tileset.png… Y después ejecutar el script de generación del juego correspondiente de tu
sistema operativo que se encuentra en la carpeta raiz.

Windows

Doble clic en make-game.bat

Linux y MacOS

Ejecutar script en la consola

./make-game.sh

Después de ejecutarlo, si todo ha ido bien, el juego estará en dist/game.tap

Los ficheros de la carpeta output los puedes borrar sin problema porque son todos generados.

Presta atención al resultado de la ejecución para ver si habéis tenido algún error.

  ZX Spectrum Game Maker
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Imágenes base. Pantallas
Summary: Creación de imágenes base que utilizarás para crear tu juego

Table of Contents

Carga

Pantalla principal

Ending

HUD

Para crear tus juegos para ZX Spectrum necesitas crear/editar algunas imágenes.

Pantallas como la principal, de carga, HUD… y el Tileset o conjunto de tiles que usarás para
diseñar tu mapa y el Spriteset o conjunto de sprites como el personaje principal, enemigos…

Tienes que crear 4 pantallas en PNG en la carpeta assets/screens loading.png, title.png,
ending.png y hud.png

Para el diseño de las mismas sólo podéis utilizar la paleta de colores del ZX Spectrum, si usáis
programas especializados como ZX Paintbrush  ya lo tienen en cuenta.

Tenéis ejemplos en la misma carpeta para simplemente modificar las pantallas existentes y ver que
requisitos tienen (tamaño…)

Carga
Esta imagen (assets/screens/loading.png) será usada en la pantalla de carga. Es la que se muestra
mientras tu juego está cargando.
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Pantalla principal
Esta imagen (assets/screens/title.png) es la que se muestra nada más cargar el juego y que debe
contener las opciones que puede seleccionar el usuario.

1. Teclado

2. Kempston

3. Sinclair

Nos ayudaría bastante que en la pantalla de inicio añadieras nuestro logo. Puedes encontrar una
versión para spectrum aquí

Ending
Esta imagen (assets/screens/ending.png) se mostrará cuando el usuario se pase el juego.

HUD

https://gm.retrojuegos.org/images/logo_spectrum.png


Esta imagen (assets/screens/hud.png) se mostrará debajo de tu juego para indicarle al usuario
cuanta vida le queda y cuantas llaves e items ha recolectado.

Tiene el mismo tamaño que las anteriores pero solo necestas diseñar la parte de abajo.

Tags:
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Imágenes base. Tileset
Summary: Creación de la imagen que contendrá los tiles para pintar tus pantallas

Table of Contents
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Tileset
Tienes que crear (o editar) una imagen de 256x48px (assets/tiles.zxp) que se usará para diseñar
tus pantallas.

ZX Spectrum Game Maker trabaja con tiles de 8x8px, en consecuencia tienes disponibles 256 tiles
para diseñar tus escenarios.

Para crear tu tileset debes tener en cuenta algunas regla, recuerda que tienes uno de ejemplo para
simplemente editarlo.

El primer tile está reservado para el fondo.

El segundo tile está reservado para “la bala” que disparará tu protagonista. El motor hace
volteado horizontal automático para cuando disparas a un sentido u otro. Si tu “bala” tiene
sentido solo tienes que diseñarla en este tile hacia la derecha.

Los siguientes 62 tiles serán considerados como sólidos, es decir, cuando lo coloques en tu
mapa, el protagonista no podrá traspasarlos, son los típicos que se usan para paredes,
plataformas… Si quieres añadir tiles que le causen daño al personaje principal tiene que estar
en estos 62 tiles.

Los siguientes 16 tiles serán considerados plataformas estáticas. Estas seran traspasables
por el protagonirsta desde abajo.

Los tiles restantes, salvo los 4 últimos, serán considerados no sólidos.

  ZX Spectrum Game Maker
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Imágenes base. Spriteset
Summary: Creación de la imagen que contendra el sprite del personaje, enemigos...

Table of Contents
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Debes crear/editar el fichero assets/sprites.zxp de 256x32px añadiendo tus sprites (personaje,
enemigos…) y donde cada uno de estos tendrá una dimensión de 16x16px.

Primera fila
Los primeros 8 sprites están reservados para la animación del protagonista:

Los 2 primeros para el movimiento hacia la derecha

El 3ª 1er frame de subir/bajar escaleras.

El 4º para el salto hacia la derecha.

El 5º y 6º siguientes para el movimiento hacia la izquierda.

El 7º 2º frame de subir/bajar escaleras

El 8º para el salto hacia la izquierda.

Los siguientes 6 sprites (9 - 14) se usarán para las plataformas en movimiento encima de las cuales
el protagonista podrá saltar. 3 plataformas con 2 sprites de animación para cada una.

El 15 de momento queda libre.

El último sprite, el 16, se usará para mostrar la explosión del enemigo cuando lo mates.

Segunda fila
Los 16 sprites de la segunda fila se usarán para los enemigos, 2 para cada enemigo, 2 frames de
animación, es decir, podrás definir un total de 8 enemigos. Tiene que dibujar solamente los frames
del enemigo hacia la derecha.
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Enemigos hacia la izquierda
El motor si solo tienes 2 filas de sprites generará los sprites de los enemigos automáticamente
hacia la izquierda debajo de lo que se han definido quedando de la siguiente manera:

Si quieres customizar los enemigos hacia la izquierda lo único que tienes que hacer es añadir al
PNG una fila más al spriteset, entonces el motor entenderá que prefieres definir tu el espejo de los
sprites y no lo hará automáticamente. Por ejemplo en la siguiente imagen de manera manual
hemos definido que el primer enemigo hacia la izquierda tiene el mismo sprite, por lo tanto no
girará.



Para añadir una fila debajo del spriteset solo tendremos de aumentar el tamaño en altura de 32 a
48 diciendole que crezca hacía abajo. Para hacerlo desde ZX Paintbrush iremos al menú View ->
Resize picture y en Select dest. orientation seleccionaremos la 2ª opción y en height pondremos
48
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Diseñando el juego. Introducción
Tiled es una muy buena herramienta para diseñar tus pantallas. Usando Tiled puedes crear el mapa
del juego y posicionar elementos como los enemigos, llaves, items a recolectar, puertas…

Nuestro juego, aunque es configurable, por defecto tendrá un tamaño de 32x22 tiles.

El ZX Spectrum Game Maker viene con un mapa de ejemplo y te recomendamos que uses
ese editándolo
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Diseñando el juego. Configuración
general
Puedes añadir configuraciones generales de tu juego en las propiedades personalizadas el mapa.

Propiedades personalizadas:

VTPLAYER_INIT (string). Posición de memoria inicial para la música vortex (Se verá en el
capítulo de música en el juego)

VTPLAYER_MUTE (string). Posición de memoria de mute para la música vortex (Se verá en
el capítulo de música en el juego)

VTPLAYER_NEXTNOTE (string). Posición de memoria para reproducir la próxima nota para
la música vortex (Se verá en el capítulo de música en el juego)

animatePeriodEnemy (int). Número más alto, animación de los enemigos más lenta.

animatePeriodMain (int). Número más alto, animación del personaje principal más lenta.

animatePeriodTile (int). Número más alto, animación de los tiles más lenta.

bulletDistance (int). Distancia que queramos que recorra la bala. Si seteamos una distancia
corta como de 2, da el efecto de que el personaje ataca con el arma a corta distancia como
una espada.

damageAmount (int). Cuánto daño le hacen al personaje los enemigos.

enemiesRespawn (bool). Si los enemigos (no invencibles) vuelven a aparecer des pués de
matarlos al volver a entrar en la habitación.

gameName (string). Nombre del juego. Aparecerá en el título loading cuando carga y el tap
se generará con este nombre. 10 carácteres como máximo sin carácteres especiales
(acentos, ñ…)

goalItems (int). Número de items necesarios para finalizar el juego.

initialLife (int). Cantidad de vida inicial del personaje.

lifeAmount (int). Cantidad de vida que incrementa al personaje los items life.

maxEnemiesPerScreen (int). Se puede configurar la cantidad de enemigos que aparecen en
pantalla (hasta 5). Evitar poner más de los que se usan para optimizar espacio.

musicEnabled (bool). Para habilitar o deshabilitar la música AY. Si se habilita la música el
juego resultante sólo funcionará en 128K, para hacer una versión 48K tendrás que desmarcar
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guardar y volver a compilar.

shooting (bool). Con esto habilitamos o deshabilitamos el disparo del personaje.

shouldKillEnemies (bool). Con esta propiedad activa, si una habitación tiene enemigos, no
podremos salir de ella hasta que los matemos a todos.

backgroundAttribute (int). Color de fondo del juego en decimal en forma de atributos de
spectrum. Por ejemplo para color de fondo negro con sprites en blanco seria 7 (00000111).
Para color de fondo azul con sprites en blanco seria 15 (00001111). Si no se define este
atributo se pintara fondo negro sprites blancos. Podéis usar la calculadora siguiente para
saber que valor tenéis que poner.

Generador de Atributos ZX Spectrum

Color de Tinta: Blanco

Color de Papel: Negro

Brillo: 

Parpadeo: 

Generar Atributo

Tags:
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Diseñando el juego. Crear el mapa
Summary: Creación de imágenes base que utilizarás para crear tu juego

El ZX Spectrum Game Maker viene con un mapa de ejemplo y te recomendamos que uses ese
editándolo. Pero explicamos que propiedades debe tener por si decides crear uno.

Cuando crees el mapa tienes que seleccionar las siguientes propiedades:

Orientation: Orthogonal.

Tile layer format: CSV.

Tile render order: Right Down.

Map size: Infinite.

Tile size: 8x8px.

Después ve al menu Map > Properties y marca el mapa como infinito y Output Chunk Width a 32 y
Output Chunk Height a 22
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Diseñando el juego. Preferencias
Para poder distinguir bien los tiles y la división entre pantallas ve al menú Preferences > Interface y
introduce en Major grid 32 tiles x 22 tiles.
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Diseñando el juego. Tilesets
Es la hora de añadir a nuestro programa de diseño Tiled el tileset y el spriteset para poder utilizarlo
en el mismo y diseñar nuestras pantallas.

Tienes que crear 2 tilesets, uno para tiles importando la imagen assets/tiles.png de 8x8px y otro
para spriteset de 16x16px importando assets/sprites.png

Es importante seleccionar Object Aligment Top Left en las propiedades de los dos tilesets. Para
acceder a esetas propiedades tienes que hacer clic en el icono con forma de documento con llave
inglesa que está en la parte inferior derecha.
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Diseñando el juego. Dibujando el mapa
Table of Contents

Uso básico de Tiled

Consideraciones generales

– Filas uniformes

– Habitaciones completas

Crear capas

Uso básico de Tiled
Usar Tiled es muy sencillo e intuitivo y tienes una documentación muy completa sobre ello
https://doc.mapeditor.org/en/stable/ . Aún así os dejamos unos tips muy básicos:

Para pintar tiles en el mapa es necesitas tener la capa map seleccionada y después seleccionar
alguna herramienta de inserción como la brocha de estampar o la herramienta de rellenado.

Para añadir los enemigo, los puntos como de fin de trayecto del mismo (movimiento) o de inicio del
protagonista, deberás tener la capa objects seleccionada y usar una de las herramientas de añadir.
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Consideraciones generales

Filas uniformes
Los mapas tiene que tener todas las filas con el mismo número de columnas, por ejemplo, si
nuestro mapa tiene 2 “pisos” y en la planta baja hay 5 habitaciones, todos los pisos deben de tener
5 habitaciones. Si no puede acceder el usuario no pasa nada, las rellenas con el primer tile (fondo)
y ya está.

Ejemplo com filas distintas (incorrecto):

El mismo ejemplo con filas uniformes, todas las filas tienen las mismas “habitaciones”



Habitaciones completas
Las habitaciones tiene que estar completas, no se pueden diseñar habitaciones que les falten tiles
o por ejemplo 2 habitaciones y media.

Crear capas
Necesitamos 2 capas, una para pintar nuestro escenario y otra para situar los elementos, como
enemigos, en el mismo.
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Diseñando el juego. Añadiendo enemigos
Table of Contents

Limitación

Posición inicial

Posición final

Tipos de movimiento

Cantidad de vida

Enemigos invencibles

Limitación
Puedes añadir hasta 3 enemigos en cada pantalla y configurar su movimiento.

Posición inicial
Para ello deberás seleccionar la capa objects y arrastrar el 1er sprite del enemigo a posicionar
donde quieras que aparezca inicialmente.

Como truco, si pulsas la tecla Ctrl el enemigo se situará respetado la rejilla.

En la propiedad type de este objeto deberás introducir el text enemy

Es recomendable que le pongas un nombre al mismo para cuando referencies la posición final a
este. E.g. enemy_1

Posición final
Haz clic en el botón Insert point.

Pon este punto donde quieras que pare el enemigo manteniendo la tecla Ctrl.

Añade a este punto una propiedad personalizada (custom property) de tipo objeto y
selecciona el enemigo relacionado con este punto.
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Tipos de movimiento
El enemigo permite 3 tipos de movimiento:

Horizontal, el enemigo y su trayecto están a la misma altura, es decir, la y del enemigo y del
punto de destino son iguales y las x distintas.



Vertical, el enemigo y su trayecto están en la misma vertical, es decir, la x del enemigo x del
punto de destino son iguales y las y distintas.

Diagonal, el enemigo y el punto final no están a la misma altura ni en la misma vertical, es
decir, ni la x del enemigo ni la y coinciden con la del punto de destino.



Cantidad de vida
Puedes asignarle la cantidad de vida que tiene cada enemigo, por ejemplo si le pones cantidad de
vida 5 el protagonista le tendrá que disparar 5 veces para matarlo.

Para ello solo tienes que añadir una propiedad personalizada life de tipo int con el valor de la vida.
Si no la defines, por defecto, el enemigo tiene una unidad de vida.



Enemigos invencibles
Para añadir enemigos invencibles solo tendras que ponerle en el atributo life el valor 99.
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Diseñando el juego. Añadiendo objetos
Table of Contents

Item

Puerta que necesita llave

Llave

Puerta que necesita que mates a todos los
enemigos

Vida

Tile de daño

Tiles animados

Tiles de daño animados

Los tiles que representan objetos se tendran que situar los 4 últimos del sprite set (188, 189, 190,
191).

IMPORTANTE: De estos 4 objetos (Item, Puerta para llave, Llave y Vida) solo se puede usar uno
de ellos por pantalla, por ejemplo, en una pantalla puedes poner una llave, una puerta y un item,
pero no 2 llaves o 2 puertas.

Item
Este es el objeto que el protagonista deberá ir recogiendo por todo el juego para finalizar el mismo
(Es configurable).

Tienes que seleccionar el tile que quieras usar para este fin, por ejemplo en el juego de Krilin la
daga, y poner que el tipo de el mismo es item.

Para ello haz clic en la rueda dentada de propiedades del tileset, selecciona el tile que desees (la
daga por ejemplo) y escribe item en la casilla type.
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Puerta que necesita llave
Este tile será considerado solido para el protagonista. deberás tener al menos una key para abrir la
puerta y cuando lo hagas se te restará de tu inventario.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe door en la casilla type.

Después ya puedes añadirlo a tu mapa arrastrándolo.

Llave
Como habrás podido ver en el párrafo anterior, necesitas el objeto key para abrir las puertas.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe key en la casilla type.

Después ya puedes añadirlo a tu mapa arrastrándolo.

Puerta que necesita que mates a todos los enemigos
Para utilizar esta puerta debes habilitar la opción shouldKillEnemies. El tile nº 64 (el último de la
segunda fila), esta designado para añadir este tipo de puerta, solo añadirlo a tu mapa arrastrándolo.
Deberás matar a todos los enemigos para abrir la puerta.



Vida
Este objeto permitirá al personaje restablecer una cantidad de vida (configurable).

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe life en la casilla type.

Después ya puedes añadirlo a tu mapa arrastrándolo.

Tile de daño
Este tipo de tile dañará al personaje principal cuando lo toque y este saldrá rebotado.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe damage en la casilla type.

Importante solo puedes marcar tiles de daño tiles no sólidos, es decir, después de las
plataformas traspasables, a partir del tile 78.

Tiles animados
En ocasiones le da un aspecto más agradable que los escenarios tengan ciertos tiles animados, por
ejemplo, unas velas a las que se le mueven las llamas.

Para ello deberás tener preparado tu tileset con el tile que tengas pensado animar y justamente el
siguiente tile sea el frame al que se intercambiará para simular el movimiento.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe animated en la casilla type.



Tiles de daño animados
A veces es interesante setear un tile con las dos propiedades anteriores, que hagan daño y que
sean animados, por ejemplo una lava que tiene que dañar al protagonista y se tiene que mover. En
este caso la el tipo o class (en las nievas versiones le han llamado class) ha de ser animated-
damage.



Como pasaba con los tiles de daño, solo puedes marcar tiles de “daño animados” tiles no sólidos,
es decir, después de las plataformas traspasables, a partir del tile 78.

Tags:



©2024 Copyright 2023 rtorralba. All rights reserved.
Site last generated: Sep 30, 2024



Diseñando el juego. Añadiendo
plataformas móviles

Table of Contents

Limitación

Cómo añadirlas

Limitación
La limitación es compartida con los enemigos. Puedes añadir 3 elementos móviles contando con
los enemigos, es decir, por ejemplo, 2 enemigos y una plataforma o 2 plataformas y 1 enemigo.

Cómo añadirlas
Las plataformas móviles se añaden igual que los enemigos con la única diferencia de que en lugar
de ponerle tipo enemy tienes que poner platform

De momento solo se permiten plataformas de movimiento horizontal.
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Sonido. Efectos FX
Para personalizar los efectos de sonido debes utilizar la aplicación de shiru8bit  BeepFX
(http://shiru.untergrund.net/files/beepfx.zip)

ZX Game Maker necesita que definas 7 sonidos. Se reproducirán cuando en el juego sucedan
cualquiera de las siguiente acciones:

Eliminar enemigo

Daño enemigo. Cuando la bala golpea al enemigo pero no le mata.

Disparo

Llave. Cuando el personaje recoge una llave.

Abrir puerta

Item. Cuando el personaje recoge un item.

Vida. Cuando el personaje recoge un elemento que le recupera vida.
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http://shiru.untergrund.net/
http://shiru.untergrund.net/
http://shiru.untergrund.net/
https://gm.retrojuegos.org/index.html


Exportar para ZX Game Maker
Para exportar tus efectos de sonido para el ZX Spectrum Game Maker, sólo tendrás que ir al menu
File > Compile.

Seleccionar Tap image

En Code address poner 49152

Seleccionar Include player code

Deseleccionar Include basic test

Pulsar Compile

Guardar el archivo en tu carpeta assets/fx con el nombre fx.tap



Solo con esto, al volver a ejecutar el generador de juego (make-game), ya se aplicarán tu sonidos.

Si esto lo ves complicado y quieres dejarlo para más adelante, ya tienes unos sonidos
predeterminados.

Si decides usar estos sonidos predeterminados, es muy importante que en tu juego pongas
la atribución al autor que es shiru8bit 
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Sonido. Música
Table of Contents

Descarga de Vortex Tracker II

Exportación con Vortex Tracker II

Descarga de Vortex Tracker II
Para hacer nuestra música usaremos el Vortex Tracker II.

DESCARGA 

Exportación con Vortex Tracker II
La podéis hacer vosotros mismos o tal vez alguien que entienda de musiquilla os lo puede pasar en
forma de proyecto.pt3.

Una vez ya con la música hecha, hay que exportar el proyecto a un fichero music.tap dentro de la
carpeta assets/music, es decir la ruta quedará assets/music/music.tap

Para exportar iremos a la opción File > Exports > Save with ZX Spectrum player
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Tenéis que poner en la opción Compilation address el valor que os da en el título como máximo.
No le des a OK de momento que tienes que copiar unos valores en tu proyecto.

Ahora antes de cerrar tenéis que copiar los valores que os ha dado a la derecha en las propiedades
de tu mapa en tiled (tienen que ser de tipo string).



Ahora tenéis que seleccionar la opción .TAP-file (player and module separately), darle a OK y
guardar el fichero como music.tap en la carpeta **assets/music



Ya finalmente hay que crear una propiedad en nuestro mapa de tipo bool para activar o desactivar
la música que llamaremos musicEnabled
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Generando el juego. Windows
Todo lo relativo a tu proyecto está dentro de la carpeta assets, te recomiendo que vayas haciendo
copia de esta carpeta de manera manual o con un sistema versionado.

Hacer doble click en el siguiente archivo. El juego se generará en la carpeta dist junto con el mapa
de memoria para que veas como vas de recursos.

make-game-win.bat

Para actualizar el motor solo habrá que hacer docle clic en el fichero update.bat

update.bat

Al generar el juego también se generará en la carpeta dist una imágen con una representación
gráfica de la memoria que ocupa tu proyecto para poder saber que ocupa cada elemento.

Nota: Asegurate de tener el docker ejecutándose antes de ejecutar el archivo make-game-win.bat.

  ZX Spectrum Game Maker
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Generando el juego. Linux y MacOS
Todo lo relativo a tu proyecto está dentro de la carpeta assets, te recomiendo que vayas haciendo
copia de esta carpeta de manera manual o con un sistema versionado.

En la consola de comandos dentro de la carpeta de tu juego. El juego se generará en la carpeta
dist junto con el mapa de memoria para que veas como vas de recursos.

./make-game.sh

Si se quiere actualizar el motor solo tendremos que añadir la opción –update

./make-game.sh --update

Al generar el juego también se generará en la carpeta dist una imágen con una representación
gráfica de la memoria que ocupa tu proyecto para poder saber que ocupa cada elemento.

Nota: En la versión MacOS asegurate de tener el docker ejecutandose.
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Release notes. 2024-01-16
Table of Contents

Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Generar el juego en la carpeta dist para mejor organización de manera que todo lo que hay
en output es temporal y borrable.

Poder generar el juego con su nombre para que aparezca en la pantalla de carga y nombre el
tap.

Creación de fichero *.zxp pari tiles y sprites para editarlos desde ZX Paintbrush

Disminuido tiempo de invencibilidad a la mitad

Añadida generación de imagen de memoria para ver espacio restante y en que se está
consumiendo.
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Mejoras técnicas
Optimizada la velocidad de carga de pantalla en un 75,5%. Tras 3 optimizaciones se ha
rebajado el tiempo de carga de 45 a 11 frames.
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Release notes. 2024-04-29
Table of Contents

Nuevas funcionalidades

Nuevas funcionalidades
Color de fondo configurable.

Puertas que se abren al eliminar los enemigos.

Plataformas traspasables desde abajo.

Posibilidad de personalizar la flip horizontal de sprites enemigos.

Enemigos invencibles.

Coger los datos para tiles y sprites directamente de ZX Paintbrush (.zxp) para mantener
información como, ink, paper, bright, flash… y evitar tener que exportar a png.

Mejorado enfoque de tiles de daño.

Posibilidad de setear si los enemigos del juego tienen respawn

Posibilidad de configurar la velocidad de animación de enemigos, personaje principal y tiles
animados.
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Release notes. 2024-01-07
Table of Contents

Nuevas funcionalidades

Mejoras técnicas

Errores corregidos

Nuevas funcionalidades
Posibilidad de establecer el nombre del juego desde Tiled para que aparezca en el loader y
genere el tap con el mismo

Mejoras técnicas
Movida música a banco de memoria de 128K para que no ocupe espacio en 48K ya que ahí
no se va a poder reproducir y que se puedan emplear los 48K compleatos para maps,
enemigos…

Errores corregidos
Error al seleccionar Kempston en la pantalla de inicio.
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Release notes. 2024-01-16
Table of Contents

Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Generar el juego en la carpeta dist para mejor organización de manera que todo lo que hay
en output es temporal y borrable.

Poder generar el juego con su nombre para que aparezca en la pantalla de carga y nombre el
tap.

Creación de fichero *.zxp pari tiles y sprites para editarlos desde ZX Paintbrush

Disminuido tiempo de invencibilidad a la mitad

Añadida generación de imagen de memoria para ver espacio restante y en que se está
consumiendo.
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Mejoras técnicas
Optimizada la velocidad de carga de pantalla en un 75,5%. Tras 3 optimizaciones se ha
rebajado el tiempo de carga de 45 a 11 frames.
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Release notes. 2023-12-03
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Nuevas funcionalidades

Mejoras técnicas

Errores corregidos

Nuevas funcionalidades
Capacidad de añadir hasta 5 enemigos

Mejoras técnicas
Ajustados limites de pantalla al cambiar de una “habitación” a otra

Compresión de datos de enemigos

Unificar configuraciones

Limpieza de código

Errores corregidos
Personaje principal incrustado. El personaje no respetaba la distancia mínima para
aparecer en la siguiente “habitación”

Repintado erroneo de tiles. Se repintaban tiles de la anterior pantalla en los que estaba
algún sprite
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Release notes. 2024-01-07
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Nuevas funcionalidades

Mejoras técnicas

Errores corregidos

Nuevas funcionalidades
Posibilidad de establecer el nombre del juego desde Tiled para que aparezca en el loader y
genere el tap con el mismo

Mejoras técnicas
Movida música a banco de memoria de 128K para que no ocupe espacio en 48K ya que ahí
no se va a poder reproducir y que se puedan emplear los 48K compleatos para maps,
enemigos…

Errores corregidos
Error al seleccionar Kempston en la pantalla de inicio.
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Release notes. 2023-11-26
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Música en el juego. Puedes añadir música con vortex player

Plataformas móviles. Ya se pueden añadir plataformas móviles

Mejoras técnicas
Optimización de detección de colisiones en personaje principal, enemigos y bala

Limpieza de código
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Release notes. 2023-12-03
Table of Contents

Nuevas funcionalidades

Mejoras técnicas

Errores corregidos

Nuevas funcionalidades
Capacidad de añadir hasta 5 enemigos

Mejoras técnicas
Ajustados limites de pantalla al cambiar de una “habitación” a otra

Compresión de datos de enemigos

Unificar configuraciones

Limpieza de código

Errores corregidos
Personaje principal incrustado. El personaje no respetaba la distancia mínima para
aparecer en la siguiente “habitación”

Repintado erroneo de tiles. Se repintaban tiles de la anterior pantalla en los que estaba
algún sprite
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Release notes. 2023-11-19
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Tiles que hacen daño

Tiles animados

Tiles que hacen daño y están animados

Vida de los enemigos. La posibilidad de poder setear a cada enemigo de la pantalla que
cantidad de golpes hay que darle para que muera.

Respawn de enemigos. Poder configurar si los enemigos volverán a aparecer aunque los
hayas matado cuando vuelves a entrar en la habitación.

Movimiento de los enemigos en todas las direcciones. (Horizontal, vertical y diagonal)

Distancia de la bala. Posibilidad de configurar que alcance tiene la bala.

Habilitar/Deshabilitar disparo. Posibilidad de decidir si el personaje puede disparar o no.

Obligación de matar a los enemigos Si esta propiedad está activa, cuando el protagonista
entra en una habitación con enemigos, está obligado a matar a todos los enemigos para
acceder a otra.

Efectos de sonido a medida. Poder crear los efectos de sonido para las distintas acciones
que acontecen en el juego (disparo, recolectar item…)

Volteado de bala. El motor volteará horizontalmente la bala en función de si el protagonista
dispara a derecha o izquierda.

Mejoras técnicas
Suavizado de animaciones

Compresión de mapa
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Autocorreción de screens. Si el usuario usa colores no permitidos en ZX Spectrum, la
autocorrección lo reemplazará con el color se spectrum más parecido.

Autocorreción de posición de elementos. Si el usuario coloca algún objeto (enemigo,
punto…) en una posición intermedia (40.5), este se aproximará al punto correcto más
cercano.
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Release notes. 2023-11-26
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Música en el juego. Puedes añadir música con vortex player

Plataformas móviles. Ya se pueden añadir plataformas móviles

Mejoras técnicas
Optimización de detección de colisiones en personaje principal, enemigos y bala

Limpieza de código
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Tiles que hacen daño

Tiles animados

Tiles que hacen daño y están animados

Vida de los enemigos. La posibilidad de poder setear a cada enemigo de la pantalla que
cantidad de golpes hay que darle para que muera.

Respawn de enemigos. Poder configurar si los enemigos volverán a aparecer aunque los
hayas matado cuando vuelves a entrar en la habitación.

Movimiento de los enemigos en todas las direcciones. (Horizontal, vertical y diagonal)

Distancia de la bala. Posibilidad de configurar que alcance tiene la bala.

Habilitar/Deshabilitar disparo. Posibilidad de decidir si el personaje puede disparar o no.

Obligación de matar a los enemigos Si esta propiedad está activa, cuando el protagonista
entra en una habitación con enemigos, está obligado a matar a todos los enemigos para
acceder a otra.

Efectos de sonido a medida. Poder crear los efectos de sonido para las distintas acciones
que acontecen en el juego (disparo, recolectar item…)

Volteado de bala. El motor volteará horizontalmente la bala en función de si el protagonista
dispara a derecha o izquierda.

Mejoras técnicas
Suavizado de animaciones

Compresión de mapa
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Autocorreción de screens. Si el usuario usa colores no permitidos en ZX Spectrum, la
autocorrección lo reemplazará con el color se spectrum más parecido.

Autocorreción de posición de elementos. Si el usuario coloca algún objeto (enemigo,
punto…) en una posición intermedia (40.5), este se aproximará al punto correcto más
cercano.
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ZX Spectrum Game Maker
Summary: Herramienta para crear juegos para ZX Spectrum de manera visual.

Table of Contents

Introducción

Documentación en vídeo

Tech

Telegram

Introducción
Herramienta para crear juegos para ZX Spectrum de manera visual usando Tiled  y el editor de
imágenes que prefieras.

Recomendamos usar ZX Paintbrush , pero puedes usar el editor que quieras siempre y cuando
las imágenes cumplan las restricciones del ZX Spectrum (color, tamaño)

Fase Beta IMPORTANTE

ZX Spectrum Game Maker se encuentra todavía en una fase beta con funcionalidades pendientes
y a falta de un testeo intensivo. No se recomienda para un uso ya final, si bien tiene un estado muy
avanzado en muchas de sus posibilidades, hay que ser consciente que no está en estado de
lanzamiento.

Documentación en vídeo
Curso por módulos en el canal de Juanje Juega :
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1. Instalación e Imágenes 

2. Diseñando el juego 1/2 

3. Diseñando el juego 2/2 

4. FX y Música 

Podéis ver una presentación WIP en el siguiente vídeo:

Video en Arnau Jess 

Tech
ZX Game Maker usa Boriel’s ZX Basic , GuSprites sprites library  y python para scripting

Telegram
Si tienes dudas y quieres participar con otros desarrolladores que están usando el ZX Game Maker,
podéis acceder al siguiente canal de Telegram:

Grupo de Telegram: https://t.me/zx_spectrum_game_maker 

Tags: getting_started
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Y a todo el grupo de ZX Basic de Boriel de Telegram
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Instalación. ZX Paintbrush
Summary: Necesitas un editor de imágenes para diseñar algunas pantallas de tu juego
como la pantalla inicial, carga, principal... Y el conjunto de tiles (los cuadraditos que sirven
para diseñar las pantallas) y sprites (Personaje principal, enemigos...).

Table of Contents

Instalación

¿Porque el ZX Paintbrush?

Instalación
Necesitas un editor de imágenes para diseñar algunas pantallas de tu juego como la pantalla inicial,
carga, principal… Y el conjunto de tiles (los cuadraditos que sirven para diseñar las pantallas) y
sprites (Personaje principal, enemigos…).

Cada una de las imágenes del engine tiene su fichero .zxp (loading.zxp, title.zxp, hud.zxp,
ending.zxp) para que lo edites desde ZX Paintbrush cuando tengas que generar el juego.

ZX PAINTBRUSH 

Si eres usuario de linux o mac lo podrás ejecutar perfectamente con wine.

¿Porque el ZX Paintbrush?
Inicialmente el motor trabajaba con png, pero las imágenes para zx paintbrush tiene más datos de
los que un png puede guardar:

De los dos colores de un caracter cual es el “paper” o el “ink”

Brillo del caracter activado o desactivado

Flash del caracter activado o desactivado

Podriamos haber seleccionado otro programa que tambien maneje estos datos, pero por secillez de
uso, funcionalidades y facilidad de manejo de ficheros del proyecto hemos elegido el ZX Paintbrush
de Claus Jahn
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Instalación. Tiled.
Summary: Este Game Maker usa Tiled para diseñar el mapa de tu juego y posicionar
todos los elementos en el mismo.

Este Game Maker usa Tiled para diseñar el mapa de tu juego y posicionar todos los elementos en
el mismo.

Además desde el mismo programa podrás configurar opciones generales de tu juego.

DOWNLOAD TILED 
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Instalación. Docker
Summary: Herramienta para que el ZX Game Maker funcione en todos los Sistemas
Operativos (Windows, Mac OS y Linux)

Para que este game maker funcione correctamente en todos los sistemas operativos, lo hemos
“empaquetado” usando la tecnología docker, de manera que simplemente instalando esta
tecnología en tu ordenador, deberías poder generar tu juego.

DOCKER 
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Instalación. Tu Proyecto.
Una vez instaladas las herramientas ya solo tienes que descargarte el “skeleton” de tu
juego/proyecto, que es como una plantilla con un juego muy sencillo para que ya tengas todo
preconfigurado, y que puedes cambiarlo para hacer tu juego.

DESCARGAR EL SKELETON DEL PROYECTO 

Todo lo que influye a la hora de generar tu juego se encuentra en la carpeta assets, con lo que os
recomiendo que vayáis haciendo copia de esa carpeta por el método que prefiáis (Copia manual,
control de versiones…).

La manera de trabajar es simplemente modificar los elementos dentro de la carpeta assets,
maps.tmx, tileset.png… Y después ejecutar el script de generación del juego correspondiente de tu
sistema operativo que se encuentra en la carpeta raiz.

Windows

Doble clic en make-game.bat

Linux y MacOS

Ejecutar script en la consola

./make-game.sh

Después de ejecutarlo, si todo ha ido bien, el juego estará en dist/game.tap

Los ficheros de la carpeta output los puedes borrar sin problema porque son todos generados.

Presta atención al resultado de la ejecución para ver si habéis tenido algún error.

  ZX Spectrum Game Maker
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Imágenes base. Pantallas
Summary: Creación de imágenes base que utilizarás para crear tu juego

Table of Contents

Carga

Pantalla principal

Ending

HUD

Para crear tus juegos para ZX Spectrum necesitas crear/editar algunas imágenes.

Pantallas como la principal, de carga, HUD… y el Tileset o conjunto de tiles que usarás para
diseñar tu mapa y el Spriteset o conjunto de sprites como el personaje principal, enemigos…

Tienes que crear 4 pantallas en PNG en la carpeta assets/screens loading.png, title.png,
ending.png y hud.png

Para el diseño de las mismas sólo podéis utilizar la paleta de colores del ZX Spectrum, si usáis
programas especializados como ZX Paintbrush  ya lo tienen en cuenta.

Tenéis ejemplos en la misma carpeta para simplemente modificar las pantallas existentes y ver que
requisitos tienen (tamaño…)

Carga
Esta imagen (assets/screens/loading.png) será usada en la pantalla de carga. Es la que se muestra
mientras tu juego está cargando.
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Pantalla principal
Esta imagen (assets/screens/title.png) es la que se muestra nada más cargar el juego y que debe
contener las opciones que puede seleccionar el usuario.

1. Teclado

2. Kempston

3. Sinclair

Nos ayudaría bastante que en la pantalla de inicio añadieras nuestro logo. Puedes encontrar una
versión para spectrum aquí

Ending
Esta imagen (assets/screens/ending.png) se mostrará cuando el usuario se pase el juego.

HUD

https://gm.retrojuegos.org/images/logo_spectrum.png


Esta imagen (assets/screens/hud.png) se mostrará debajo de tu juego para indicarle al usuario
cuanta vida le queda y cuantas llaves e items ha recolectado.

Tiene el mismo tamaño que las anteriores pero solo necestas diseñar la parte de abajo.
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Imágenes base. Tileset
Summary: Creación de la imagen que contendrá los tiles para pintar tus pantallas

Table of Contents

Tileset

Tileset
Tienes que crear (o editar) una imagen de 256x48px (assets/tiles.zxp) que se usará para diseñar
tus pantallas.

ZX Spectrum Game Maker trabaja con tiles de 8x8px, en consecuencia tienes disponibles 256 tiles
para diseñar tus escenarios.

Para crear tu tileset debes tener en cuenta algunas regla, recuerda que tienes uno de ejemplo para
simplemente editarlo.

El primer tile está reservado para el fondo.

El segundo tile está reservado para “la bala” que disparará tu protagonista. El motor hace
volteado horizontal automático para cuando disparas a un sentido u otro. Si tu “bala” tiene
sentido solo tienes que diseñarla en este tile hacia la derecha.

Los siguientes 62 tiles serán considerados como sólidos, es decir, cuando lo coloques en tu
mapa, el protagonista no podrá traspasarlos, son los típicos que se usan para paredes,
plataformas… Si quieres añadir tiles que le causen daño al personaje principal tiene que estar
en estos 62 tiles.

Los siguientes 16 tiles serán considerados plataformas estáticas. Estas seran traspasables
por el protagonirsta desde abajo.

Los tiles restantes, salvo los 4 últimos, serán considerados no sólidos.

  ZX Spectrum Game Maker
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Imágenes base. Spriteset
Summary: Creación de la imagen que contendra el sprite del personaje, enemigos...

Table of Contents

Primera fila

Segunda fila

Enemigos hacia la izquierda

Debes crear/editar el fichero assets/sprites.zxp de 256x32px añadiendo tus sprites (personaje,
enemigos…) y donde cada uno de estos tendrá una dimensión de 16x16px.

Primera fila
Los primeros 8 sprites están reservados para la animación del protagonista:

Los 2 primeros para el movimiento hacia la derecha

El 3ª 1er frame de subir/bajar escaleras.

El 4º para el salto hacia la derecha.

El 5º y 6º siguientes para el movimiento hacia la izquierda.

El 7º 2º frame de subir/bajar escaleras

El 8º para el salto hacia la izquierda.

Los siguientes 6 sprites (9 - 14) se usarán para las plataformas en movimiento encima de las cuales
el protagonista podrá saltar. 3 plataformas con 2 sprites de animación para cada una.

El 15 de momento queda libre.

El último sprite, el 16, se usará para mostrar la explosión del enemigo cuando lo mates.

Segunda fila
Los 16 sprites de la segunda fila se usarán para los enemigos, 2 para cada enemigo, 2 frames de
animación, es decir, podrás definir un total de 8 enemigos. Tiene que dibujar solamente los frames
del enemigo hacia la derecha.
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Enemigos hacia la izquierda
El motor si solo tienes 2 filas de sprites generará los sprites de los enemigos automáticamente
hacia la izquierda debajo de lo que se han definido quedando de la siguiente manera:

Si quieres customizar los enemigos hacia la izquierda lo único que tienes que hacer es añadir al
PNG una fila más al spriteset, entonces el motor entenderá que prefieres definir tu el espejo de los
sprites y no lo hará automáticamente. Por ejemplo en la siguiente imagen de manera manual
hemos definido que el primer enemigo hacia la izquierda tiene el mismo sprite, por lo tanto no
girará.



Para añadir una fila debajo del spriteset solo tendremos de aumentar el tamaño en altura de 32 a
48 diciendole que crezca hacía abajo. Para hacerlo desde ZX Paintbrush iremos al menú View ->
Resize picture y en Select dest. orientation seleccionaremos la 2ª opción y en height pondremos
48
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Diseñando el juego. Introducción
Tiled es una muy buena herramienta para diseñar tus pantallas. Usando Tiled puedes crear el mapa
del juego y posicionar elementos como los enemigos, llaves, items a recolectar, puertas…

Nuestro juego, aunque es configurable, por defecto tendrá un tamaño de 32x22 tiles.

El ZX Spectrum Game Maker viene con un mapa de ejemplo y te recomendamos que uses
ese editándolo
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Diseñando el juego. Configuración
general
Puedes añadir configuraciones generales de tu juego en las propiedades personalizadas el mapa.

Propiedades personalizadas:

VTPLAYER_INIT (string). Posición de memoria inicial para la música vortex (Se verá en el
capítulo de música en el juego)

VTPLAYER_MUTE (string). Posición de memoria de mute para la música vortex (Se verá en
el capítulo de música en el juego)

VTPLAYER_NEXTNOTE (string). Posición de memoria para reproducir la próxima nota para
la música vortex (Se verá en el capítulo de música en el juego)

animatePeriodEnemy (int). Número más alto, animación de los enemigos más lenta.

animatePeriodMain (int). Número más alto, animación del personaje principal más lenta.

animatePeriodTile (int). Número más alto, animación de los tiles más lenta.

bulletDistance (int). Distancia que queramos que recorra la bala. Si seteamos una distancia
corta como de 2, da el efecto de que el personaje ataca con el arma a corta distancia como
una espada.

damageAmount (int). Cuánto daño le hacen al personaje los enemigos.

enemiesRespawn (bool). Si los enemigos (no invencibles) vuelven a aparecer des pués de
matarlos al volver a entrar en la habitación.

gameName (string). Nombre del juego. Aparecerá en el título loading cuando carga y el tap
se generará con este nombre. 10 carácteres como máximo sin carácteres especiales
(acentos, ñ…)

goalItems (int). Número de items necesarios para finalizar el juego.

initialLife (int). Cantidad de vida inicial del personaje.

lifeAmount (int). Cantidad de vida que incrementa al personaje los items life.

maxEnemiesPerScreen (int). Se puede configurar la cantidad de enemigos que aparecen en
pantalla (hasta 5). Evitar poner más de los que se usan para optimizar espacio.

musicEnabled (bool). Para habilitar o deshabilitar la música AY. No es necesario que la
deshabilites para generar el juego en 48k, el mismo juego con música funciona tanto en 48k
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como en 128k , simplemente en el 48k no suena la música.

shooting (bool). Con esto habilitamos o deshabilitamos el disparo del personaje.

shouldKillEnemies (bool). Con esta propiedad activa, si una habitación tiene enemigos, no
podremos salir de ella hasta que los matemos a todos.

backgroundAttribute (int). Color de fondo del juego en decimal en forma de atributos de
spectrum. Por ejemplo para color de fondo negro con sprites en blanco seria 7 (00000111).
Para color de fondo azul con sprites en blanco seria 15 (00001111). Si no se define este
atributo se pintara fondo negro sprites blancos. Podéis usar la calculadora siguiente para
saber que valor tenéis que poner.

Generador de Atributos ZX Spectrum

Color de Tinta: Blanco

Color de Papel: Negro

Brillo: 

Parpadeo: 

Generar Atributo

Tags:
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Diseñando el juego. Crear el mapa
Summary: Creación de imágenes base que utilizarás para crear tu juego

El ZX Spectrum Game Maker viene con un mapa de ejemplo y te recomendamos que uses ese
editándolo. Pero explicamos que propiedades debe tener por si decides crear uno.

Cuando crees el mapa tienes que seleccionar las siguientes propiedades:

Orientation: Orthogonal.

Tile layer format: CSV.

Tile render order: Right Down.

Map size: Infinite.

Tile size: 8x8px.

Después ve al menu Map > Properties y marca el mapa como infinito y Output Chunk Width a 32 y
Output Chunk Height a 22
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Diseñando el juego. Preferencias
Para poder distinguir bien los tiles y la división entre pantallas ve al menú Preferences > Interface y
introduce en Major grid 32 tiles x 22 tiles.

Tags:

  ZX Spectrum Game Maker

https://gm.retrojuegos.org/index.html


©2024 Copyright 2023 rtorralba. All rights reserved.
Site last generated: Apr 29, 2024



Diseñando el juego. Tilesets
Es la hora de añadir a nuestro programa de diseño Tiled el tileset y el spriteset para poder utilizarlo
en el mismo y diseñar nuestras pantallas.

Tienes que crear 2 tilesets, uno para tiles importando la imagen assets/tiles.png de 8x8px y otro
para spriteset de 16x16px importando assets/sprites.png

Es importante seleccionar Object Aligment Top Left en las propiedades de los dos tilesets. Para
acceder a esetas propiedades tienes que hacer clic en el icono con forma de documento con llave
inglesa que está en la parte inferior derecha.
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Diseñando el juego. Dibujando el mapa
Table of Contents

Uso básico de Tiled

Consideraciones generales

– Filas uniformes

– Habitaciones completas

Crear capas

Uso básico de Tiled
Usar Tiled es muy sencillo e intuitivo y tienes una documentación muy completa sobre ello
https://doc.mapeditor.org/en/stable/ . Aún así os dejamos unos tips muy básicos:

Para pintar tiles en el mapa es necesitas tener la capa map seleccionada y después seleccionar
alguna herramienta de inserción como la brocha de estampar o la herramienta de rellenado.

Para añadir los enemigo, los puntos como de fin de trayecto del mismo (movimiento) o de inicio del
protagonista, deberás tener la capa objects seleccionada y usar una de las herramientas de añadir.
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Consideraciones generales

Filas uniformes
Los mapas tiene que tener todas las filas con el mismo número de columnas, por ejemplo, si
nuestro mapa tiene 2 “pisos” y en la planta baja hay 5 habitaciones, todos los pisos deben de tener
5 habitaciones. Si no puede acceder el usuario no pasa nada, las rellenas con el primer tile (fondo)
y ya está.

Ejemplo com filas distintas (incorrecto):

El mismo ejemplo con filas uniformes, todas las filas tienen las mismas “habitaciones”



Habitaciones completas
Las habitaciones tiene que estar completas, no se pueden diseñar habitaciones que les falten tiles
o por ejemplo 2 habitaciones y media.

Crear capas
Necesitamos 2 capas, una para pintar nuestro escenario y otra para situar los elementos, como
enemigos, en el mismo.
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Diseñando el juego. Añadiendo enemigos
Table of Contents

Limitación

Posición inicial

Posición final

Tipos de movimiento

Cantidad de vida

Enemigos invencibles

Limitación
Puedes añadir hasta 3 enemigos en cada pantalla y configurar su movimiento.

Posición inicial
Para ello deberás seleccionar la capa objects y arrastrar el 1er sprite del enemigo a posicionar
donde quieras que aparezca inicialmente.

Como truco, si pulsas la tecla Ctrl el enemigo se situará respetado la rejilla.

En la propiedad type de este objeto deberás introducir el text enemy

Es recomendable que le pongas un nombre al mismo para cuando referencies la posición final a
este. E.g. enemy_1

Posición final
Haz clic en el botón Insert point.

Pon este punto donde quieras que pare el enemigo manteniendo la tecla Ctrl.

Añade a este punto una propiedad personalizada (custom property) de tipo objeto y
selecciona el enemigo relacionado con este punto.
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Tipos de movimiento
El enemigo permite 3 tipos de movimiento:

Horizontal, el enemigo y su trayecto están a la misma altura, es decir, la y del enemigo y del
punto de destino son iguales y las x distintas.



Vertical, el enemigo y su trayecto están en la misma vertical, es decir, la x del enemigo x del
punto de destino son iguales y las y distintas.

Diagonal, el enemigo y el punto final no están a la misma altura ni en la misma vertical, es
decir, ni la x del enemigo ni la y coinciden con la del punto de destino.



Cantidad de vida
Puedes asignarle la cantidad de vida que tiene cada enemigo, por ejemplo si le pones cantidad de
vida 5 el protagonista le tendrá que disparar 5 veces para matarlo.

Para ello solo tienes que añadir una propiedad personalizada life de tipo int con el valor de la vida.
Si no la defines, por defecto, el enemigo tiene una unidad de vida.



Enemigos invencibles
Para añadir enemigos invencibles solo tendras que ponerle en el atributo life el valor 99.
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Diseñando el juego. Añadiendo objetos
Table of Contents

Item

Puerta que necesita llave

Llave

Puerta que necesita que mates a todos los
enemigos

Vida

Tile de daño

Tiles animados

Tiles de daño animados

Los tiles que representan objetos se tendran que situar los 4 últimos del sprite set (188, 189, 190,
191).

IMPORTANTE: De estos 4 objetos (Item, Puerta para llave, Llave y Vida) solo se puede usar uno
de ellos por pantalla, por ejemplo, en una pantalla puedes poner una llave, una puerta y un item,
pero no 2 llaves o 2 puertas.

Item
Este es el objeto que el protagonista deberá ir recogiendo por todo el juego para finalizar el mismo
(Es configurable).

Tienes que seleccionar el tile que quieras usar para este fin, por ejemplo en el juego de Krilin la
daga, y poner que el tipo de el mismo es item.

Para ello haz clic en la rueda dentada de propiedades del tileset, selecciona el tile que desees (la
daga por ejemplo) y escribe item en la casilla type.

  ZX Spectrum Game Maker
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Puerta que necesita llave
Este tile será considerado solido para el protagonista. deberás tener al menos una key para abrir la
puerta y cuando lo hagas se te restará de tu inventario.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe door en la casilla type.

Después ya puedes añadirlo a tu mapa arrastrándolo.

Llave
Como habrás podido ver en el párrafo anterior, necesitas el objeto key para abrir las puertas.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe key en la casilla type.

Después ya puedes añadirlo a tu mapa arrastrándolo.

Puerta que necesita que mates a todos los enemigos
Para utilizar esta puerta debes habilitar la opción shouldKillEnemies. El tile nº 64 (el último de la
segunda fila), esta designado para añadir este tipo de puerta, solo añadirlo a tu mapa arrastrándolo.
Deberás matar a todos los enemigos para abrir la puerta.



Vida
Este objeto permitirá al personaje restablecer una cantidad de vida (configurable).

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe life en la casilla type.

Después ya puedes añadirlo a tu mapa arrastrándolo.

Tile de daño
Este tipo de tile dañará al personaje principal cuando lo toque y este saldrá rebotado.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe damage en la casilla type.

Importante solo puedes marcar tiles de daño tiles no sólidos, es decir, después de las
plataformas traspasables, a partir del tile 78.

Tiles animados
En ocasiones le da un aspecto más agradable que los escenarios tengan ciertos tiles animados, por
ejemplo, unas velas a las que se le mueven las llamas.

Para ello deberás tener preparado tu tileset con el tile que tengas pensado animar y justamente el
siguiente tile sea el frame al que se intercambiará para simular el movimiento.

Para setear un tile de este tipo haz clic en la rueda dentada de propiedades del tileset, selecciona el
tile que desees y escribe animated en la casilla type.



Tiles de daño animados
A veces es interesante setear un tile con las dos propiedades anteriores, que hagan daño y que
sean animados, por ejemplo una lava que tiene que dañar al protagonista y se tiene que mover. En
este caso la el tipo o class (en las nievas versiones le han llamado class) ha de ser animated-
damage.



Como pasaba con los tiles de daño, solo puedes marcar tiles de “daño animados” tiles no sólidos,
es decir, después de las plataformas traspasables, a partir del tile 78.
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Diseñando el juego. Añadiendo
plataformas móviles

Table of Contents

Limitación

Cómo añadirlas

Limitación
La limitación es compartida con los enemigos. Puedes añadir 3 elementos móviles contando con
los enemigos, es decir, por ejemplo, 2 enemigos y una plataforma o 2 plataformas y 1 enemigo.

Cómo añadirlas
Las plataformas móviles se añaden igual que los enemigos con la única diferencia de que en lugar
de ponerle tipo enemy tienes que poner platform

De momento solo se permiten plataformas de movimiento horizontal.
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Sonido. Efectos FX
Para personalizar los efectos de sonido debes utilizar la aplicación de shiru8bit  BeepFX
(http://shiru.untergrund.net/files/beepfx.zip)

ZX Game Maker necesita que definas 7 sonidos. Se reproducirán cuando en el juego sucedan
cualquiera de las siguiente acciones:

Eliminar enemigo

Daño enemigo. Cuando la bala golpea al enemigo pero no le mata.

Disparo

Llave. Cuando el personaje recoge una llave.

Abrir puerta

Item. Cuando el personaje recoge un item.

Vida. Cuando el personaje recoge un elemento que le recupera vida.
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Exportar para ZX Game Maker
Para exportar tus efectos de sonido para el ZX Spectrum Game Maker, sólo tendrás que ir al menu
File > Compile.

Seleccionar Tap image

En Code address poner 49152

Seleccionar Include player code

Deseleccionar Include basic test

Pulsar Compile

Guardar el archivo en tu carpeta assets/fx con el nombre fx.tap



Solo con esto, al volver a ejecutar el generador de juego (make-game), ya se aplicarán tu sonidos.

Si esto lo ves complicado y quieres dejarlo para más adelante, ya tienes unos sonidos
predeterminados.

Si decides usar estos sonidos predeterminados, es muy importante que en tu juego pongas
la atribución al autor que es shiru8bit 
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Sonido. Música
Table of Contents

Descarga de Vortex Tracker II

Exportación con Vortex Tracker II

Descarga de Vortex Tracker II
Para hacer nuestra música usaremos el Vortex Tracker II.

DESCARGA 

Exportación con Vortex Tracker II
La podéis hacer vosotros mismos o tal vez alguien que entienda de musiquilla os lo puede pasar en
forma de proyecto.pt3.

Una vez ya con la música hecha, hay que exportar el proyecto a un fichero music.tap dentro de la
carpeta assets/music, es decir la ruta quedará assets/music/music.tap

Para exportar iremos a la opción File > Exports > Save with ZX Spectrum player
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Tenéis que poner en la opción Compilation address el valor que os da en el título como máximo.
No le des a OK de momento que tienes que copiar unos valores en tu proyecto.

Ahora antes de cerrar tenéis que copiar los valores que os ha dado a la derecha en las propiedades
de tu mapa en tiled (tienen que ser de tipo string).



Ahora tenéis que seleccionar la opción .TAP-file (player and module separately), darle a OK y
guardar el fichero como music.tap en la carpeta **assets/music



Ya finalmente hay que crear una propiedad en nuestro mapa de tipo bool para activar o desactivar
la música que llamaremos musicEnabled
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Generando el juego. Windows
Todo lo relativo a tu proyecto está dentro de la carpeta assets, te recomiendo que vayas haciendo
copia de esta carpeta de manera manual o con un sistema versionado.

Hacer doble click en el siguiente archivo. El juego se generará en la carpeta dist junto con el mapa
de memoria para que veas como vas de recursos.

make-game-win.bat

Para actualizar el motor solo habrá que hacer docle clic en el fichero update.bat

update.bat

Al generar el juego también se generará en la carpeta dist una imágen con una representación
gráfica de la memoria que ocupa tu proyecto para poder saber que ocupa cada elemento.

  ZX Spectrum Game Maker
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Generando el juego. Linux y MacOS
Todo lo relativo a tu proyecto está dentro de la carpeta assets, te recomiendo que vayas haciendo
copia de esta carpeta de manera manual o con un sistema versionado.

En la consola de comandos dentro de la carpeta de tu juego. El juego se generará en la carpeta
dist junto con el mapa de memoria para que veas como vas de recursos.

./make-game.sh

Si se quiere actualizar el motos solo tendremos que añadir la opción –update

./make-game.sh --update

Al generar el juego también se generará en la carpeta dist una imágen con una representación
gráfica de la memoria que ocupa tu proyecto para poder saber que ocupa cada elemento.
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Release notes. 2024-01-16
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Generar el juego en la carpeta dist para mejor organización de manera que todo lo que hay
en output es temporal y borrable.

Poder generar el juego con su nombre para que aparezca en la pantalla de carga y nombre el
tap.

Creación de fichero *.zxp pari tiles y sprites para editarlos desde ZX Paintbrush

Disminuido tiempo de invencibilidad a la mitad

Añadida generación de imagen de memoria para ver espacio restante y en que se está
consumiendo.
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Mejoras técnicas
Optimizada la velocidad de carga de pantalla en un 75,5%. Tras 3 optimizaciones se ha
rebajado el tiempo de carga de 45 a 11 frames.
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Release notes. 2024-01-07
Table of Contents

Nuevas funcionalidades

Mejoras técnicas

Errores corregidos

Nuevas funcionalidades
Posibilidad de establecer el nombre del juego desde Tiled para que aparezca en el loader y
genere el tap con el mismo

Mejoras técnicas
Movida música a banco de memoria de 128K para que no ocupe espacio en 48K ya que ahí
no se va a poder reproducir y que se puedan emplear los 48K compleatos para maps,
enemigos…

Errores corregidos
Error al seleccionar Kempston en la pantalla de inicio.
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Release notes. 2023-12-03
Table of Contents

Nuevas funcionalidades

Mejoras técnicas

Errores corregidos

Nuevas funcionalidades
Capacidad de añadir hasta 5 enemigos

Mejoras técnicas
Ajustados limites de pantalla al cambiar de una “habitación” a otra

Compresión de datos de enemigos

Unificar configuraciones

Limpieza de código

Errores corregidos
Personaje principal incrustado. El personaje no respetaba la distancia mínima para
aparecer en la siguiente “habitación”

Repintado erroneo de tiles. Se repintaban tiles de la anterior pantalla en los que estaba
algún sprite
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Release notes. 2023-11-26
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Música en el juego. Puedes añadir música con vortex player

Plataformas móviles. Ya se pueden añadir plataformas móviles

Mejoras técnicas
Optimización de detección de colisiones en personaje principal, enemigos y bala

Limpieza de código
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Release notes. 2023-11-19
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Nuevas funcionalidades

Mejoras técnicas

Nuevas funcionalidades
Tiles que hacen daño

Tiles animados

Tiles que hacen daño y están animados

Vida de los enemigos. La posibilidad de poder setear a cada enemigo de la pantalla que
cantidad de golpes hay que darle para que muera.

Respawn de enemigos. Poder configurar si los enemigos volverán a aparecer aunque los
hayas matado cuando vuelves a entrar en la habitación.

Movimiento de los enemigos en todas las direcciones. (Horizontal, vertical y diagonal)

Distancia de la bala. Posibilidad de configurar que alcance tiene la bala.

Habilitar/Deshabilitar disparo. Posibilidad de decidir si el personaje puede disparar o no.

Obligación de matar a los enemigos Si esta propiedad está activa, cuando el protagonista
entra en una habitación con enemigos, está obligado a matar a todos los enemigos para
acceder a otra.

Efectos de sonido a medida. Poder crear los efectos de sonido para las distintas acciones
que acontecen en el juego (disparo, recolectar item…)

Volteado de bala. El motor volteará horizontalmente la bala en función de si el protagonista
dispara a derecha o izquierda.

Mejoras técnicas
Suavizado de animaciones

Compresión de mapa
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Autocorreción de screens. Si el usuario usa colores no permitidos en ZX Spectrum, la
autocorrección lo reemplazará con el color se spectrum más parecido.

Autocorreción de posición de elementos. Si el usuario coloca algún objeto (enemigo,
punto…) en una posición intermedia (40.5), este se aproximará al punto correcto más
cercano.
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